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color example data
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Preparatlon

. Install SMAP according to the User guide (on www.rieslab.de) section 2. To install the
compiled version, download the zip files on www.rieslab.de and follow the installation notes:
https://www.embl.de/download/ries/SMAPCompiled/Installation _notes SMAP_compiled.rt
f.

2. Download and unzip the example beads.zip and —— T
NUp107_AF647_WGA_CF680le, or for a Calibrate PSF model for MLE fit from bead stacks. (c) 2017 Ries lab
smaller example beads_subset _small.zip and

Select camera files

Nup107_AF647 WGA CF680 subset small.zip, /Nolumes/LaCie/SMAPData/Exampl
from www.rieslab.de. (see Box 1 for details) VOV
3. You can select Menu/SMAP/hide advanced Select output file  /Volumes/LaCie/SMAPData/Example/t

controls to have a simple GUI.
4. If during the following protocol things don’t work as | General parameters:

expected, try restarting SMAP and load the last file 3D modality  global 2 c... [  bidir
that was prod Uced. Distance between frames (hm) 10
5. For an introduction to SMAP, we recommend  CoTectbeadzposiionsusing  cross-corelation &)

. . . frames to use for CC: 50
fO”OWIng the gettlng started example first. Filter size for peak finding 2  Relative cutoff 1

Minimum distance (pixels) 25

Box 1: The example sample. Cspline parameters:
ROI size: X,Y (pixels): 27
Nup1 07'SNAP Iabeled Wlth BG'AlexaF|u°r647 Smoothing parameter in Z: 1

and the central channel labeled with WGA-
CF680. Homozygous CRISPR cell lines, imaged | = ©obal fit parameters:

in an MES-based oxygen depleted imaging buffer :::e':t'm oo B
as described in Thevathasan et al, Nature mainCh or [ up-downmiror [ Spit(p) 255
Methods 2019. The data was taken on a custom Spatially resolved calibration:

microscope with two spectral channels, split by a none B setframes

LP665 beam splitter and imaged on two parts of e Zomike cosfticlents. [ Parametors

the EMCCD camera. Astigmatism was introduced EM gain and mirror from metadata [}

with a cylindrical lens.

Calculate bead calibration

Status

Figure 1: GUIl to calibrate the
experimental PSF model.
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1 Calibrate experimental PSF model from bead stacks

1. Start SMAP.

2. Find the plugin calibrate3DsplinePSF either from the menu/Plugins/Analyze/sr3D or in
the Analyze tab, sr3D subtab and press . Now the GUI for the spline calibration opens.

3. [Select camera files| to load all the bead stacks. A new window opens. Here press

and select all directories in the bead directory. [Press Donél.

4. Set the parameters according to Figure 1.

a.

b.

c.
d.

As we have dual-color data in two spectral channels in two parts of the camera we
choose the 3D modality: global 2 channel.

For nicer visualization of the validation of the model you can select [] bi dir to
activate bi-directional fitting.

Set the distance between slices in the stack (in nanometers).

You can adjust the other parameters according to the User guide section 5.4.1.
An initial transformation is calculated from the bead stacks. You can choose the
main channel (in this case the bottom channel) and specify that the upper and lower
channels are mirrored horizontally with respect to each other.

We let SMAP determine the EM gain and mirror from the metadata. Otherwise, set
here if beads were acquired with the conventional or EM mode.

5. [Calculate bead calibration|. This step might take 5-10 minutes, you can see the progress in

the status bar of the plugin. You can compare your saved files with example_3dcal.fig.
Specifically, compare the tabs of the output figure with those in Figure 2.
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Figure 2: Output of the GUI calibration. A) to check if beads across
the whole field of view were paired. B) to check if the model could
properly fit the individual beads. C) Cross-section along z-axis
through model to check if the model represents the individual
beads. D) as C. but along x-axis.




2 Fit 3D dual-color [w e ™ | T

SMLM data with | =
experimental l e
PSF model B L~
. Check in the SMAP GUI at » + =
the bottom of the Localize |, S
tab that the fitting workflow |ou o o o oo o o o o coi OV fiter
fit_fastsimple is e e
selected. Otherwise load that SEarelphl] 1 [ 0

. In the main SMAP GUI select

workflow by pressing

Spline
Chan 0 e . Load 3D cal xample/beads/beads_3dcal.mat

the Localize/llnput Image

tab. “Workfiow: t_tastsimple Change  Info ¥
. Load images] and select ong | " Tt fe e e
preview done Unge | Stop p 100 200 300

of the files in the directory
Nup96 AF647 WGA CF680.
The loader might display an error message that it cannot load the images. Ignore this for
the moment and try the next steps. This error message comes from the micro-manager
code, thus it cannot easily be fixed in SMAP.

Figure 3: Fitting GUI and result of preview.

. You can adjust the parameters in the Peak Finder tab according to the User guide section

5.3.

. In the Fitter tab select and with Load 3D call load the bead calibration file that you

just generated.

. Select a large frame (e.g. 1000 as the first frames are still too dense to optimize fitting

parameters) and press . The results should be comparable to those in Figure 3.

7. Press and wait for the fitting to be done (this might take up to one hour depending
on your computer). o
8. You a have a first look at the results by pressing in the Render tab. s
lit m|
10805
3 Calculate transformation between channels 2 4.6
See User Guide section 9.1.1 +Pix;e1c 2(nm)
1. In the Format part of the GUI (Figure 4) reset the field of view with and 2 10
delete any ROI you might have drawn with @ Par |Reset
2. Filter out the bad localizations by selecting a maximum localization precision  _

w

N Ok

(e.g. 10 or 15 nm) and a minimum LogLikelihood (see User Guide section6.2). | - 159
Choose the plugin Menu/Plugins/Process/Register Localizations or in the 0o oz
tab Process/Register/Register Localizations. o R
Select [luse layers and m both for reference and target.

Select for target and for mirror [up-down). Press [Run|. IEIogrler:zt GUT

Compare the output to Figure 5.

Save the transformation with [save T].
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Figure 5: A) GUI to calculate transformation. B) the paired localizations should
span the whole field of view. C) the correlation should have a clear peak. D) the
errors should form a clear maximum in the center, the standard deviations dx

and dy should be << 1 pixel.

4 Assign intensities in both channels
Here we discuss how to assign to each localization the intensity in both channels, which is

later used to assign the color.

1. Start the plugin: menu/Plugins/Process
/Assign2C/2C intensities from images 2 cam or in the Process/Assign2C/2C
intensities from images 2 cam tab.

2. Load the raw camera images in the target field with , leave the reference field empty
(as both channels are in one file). As the images were acquired with EM gain, leave the
DEM tiCked, as We" as Dtal’get = File Localize Render - Analyze ROIs
and [lreference. _ _ _

3. Load the transformation file you =...m..c..,,_v..u.....;. = _Reglmr SRR voaty
generated above with , Intensity2ManyChannels Info

4. Have only [roi2int_expPSE 8o o e e ST Run
selected.

5. Click on roi2int_expPSF and target EM /Volumes/LaCie/SMAP load tif calculate BG
the bead calibration file that reference @ EM load tif
defines the PSF (*_3Dcal.mat). Nolumes/LaCie/SMAPData/Ex load T

6. Press . This process can take _
up to one hour again. The results :g:g:::—:t‘gne roisize 9 BG free fit fit
are automatica”y saved with the PData/Example/beads/beads_3dcal.mht load

ending _dc_sml.mat.

normalize image to Poisson noise

Fix z pos to frame:

Figure 6: The GUI
camera images.

0

to extract intensities from raw



5 Assign color from intensities

1. Select the plugin Menu/Plugins/Process/Assign2C/intensity2ManyChannels or the
same in the tabs.

Show ROls|.
Click ROI 1] and select the region of intensities for the first fluorophore.

Click ROI 2 and select the region of intensities for the second fluorophore.

Compare to Figure 7 and [Run|

In the Render tab next to Layer1 click the + tab to create Layer2. Type in 2| in the Ch field
of the tab Layer2 to

Ok wn

Only d|sp|ay - A File Localize Render [UPfOgesSH| Analyze ROIs B ankysinzy
localizations assigned - e
to channel 2. Type in [1] 2 ercres rom ocaea fun
in the Ch field of the tab ~ 2C Mensities from images Show results
Laygr1 .to only dllsplay - chamne -
localizations assigned psf_nr default Channel 2 ROI2
to channel 1. psf_nt i Channel 3 ROIN
. @1 | d Show ROIs
7. Select a different look et R S A .
u p ta b I e i n th e L U T i . .\mmﬂvin target channel (2), logarithmic scale
menu. Figure 7: A) GUI. B) Regions corresponding to the two

8. Press _ Yoy fluorophore species AF647 and CF680.
should already be able to see the dual-color image.

6 Transform second channel onto first.

To avoid any errors due to channel misalignments, you can analyze just one of the two
channels exclusively. This is especially recommended if you split the two colors not in the
middle of the spectra, but at the low end of the spectra as is done in this example. Then the
long wavelength channel is exclusively used for rendering and carries all positional information,
whereas the short wavelength channel is only used for color assignment.

You, however, have the option to transform both channels onto each other using the
transformation file you generated in section 3. It is important that this is done prior to drift
correction.

1. Select the plugin Menu/Process/ Register/Apply Transformation or the corresponding
plugin in the tab.
2. Load the transformation file with

m = Drift ~ Register  Assign2C Modify
. Apply Transformation = Inf
3. Select [Jadd to target channel [10/and ~ R2PY, Traneformetion nfo mun
Run|. Register Images Show results

4. Create two more layers as Layer 3 and
type in at Ch ’ and I—ayer 4 and type dataset: Nup96_AF647
in Ch . Alternatively display ~ ™™ target

channels 1 and 11 in Layer1 by typing locs/ifs: both

) transform z for 3D data v add to target channel 10
Ch and 2 and 12 in Layer2 by
typing Ch 2,12,
5_ You Should Check |f the transforma“on /Volumes/LaCie/SMAPData/Example/Nup96_AF647 WGA_ load T

onto each other was successful, Figure 8: GUI to transform channels onto each
otherwise this points to problems with other.
the transformation.

WGA_CF680_s... ¢ transform all files

<>

<

set channel (ref=1,target=2)

7 Perform drift correction
1. Reset view and remove any ROI you selected (see 3.1).



2. Select the plugin menu/Plugins/Process/Drift/drift correction X)Y,Z or the
corresponding tab.

3. Click the v symbol in the upper right corner to show the advanced controls.

4. Check both [ICorrect x-y drift and [ICorrect z-drift.

5. If you have transformed the channels onto each other select no mirror], otherwise select
ichannels, mirrored, vertical splif
to drift correct both channels |MESEE oz oz oo sine ] oyt oofani ooz cor M-
independently. Click Run w— nam e

6. Check if all curves scatter | |
without too much error around |
the black curve, this indicates
that all redundant displacements |
are compatible with each other | “
and that drift correction worked. .

7. Play around with the rendered |~ . . % ' . f.
image by zooming and panning '
and explore the effect of filters Figure 9: Relative displacement between blocks in
as described in the User guide redundant cross-correlation.
sections 6 and 7.

Ex

8 Generate a movie of a rotating nuclear pore complex

1. Zoom into a region of interest with nice looking NPCs.

2. Draw a line ROI through the pores, change the width of this ROI e.g. to 250 nm. Only
localizations in the rectangular ROI will be rendered in the 3D viewer (Figure 9).

3. Select the plugin menu/Analyze/sr3D/Viewer 3D or the corresponding tab.

4. Press @ The side view image should open. The render parameters (color, filtering,...)

are the same as for the main rendered image and set in the Render/Layer tab.

You can drag the line ROI; the side view reconstruction will automatically follow.

You can start a dynamic rotation by pressing . To reset to the side view press

angle|.

7. Adjust zmin/max so that the NPCs are in the center of the z range. As the rotation axis is
centered with the FOV, it is necessary to center the structure with the FOV to have proper
rotation animation.

8. [Save movie| renders a rotating animation.

9. The animation is saved as a tiff stack. You can use Fiji to export it to avi or mp4.

o o

10. For more information on the 3D viewer see the User guide section 7.6.
- ey :c File Localize Render Process [ANGMEEN ROIs

;.,é B . = measure [SEGOM cluster other NPC D“
:;a:\:: comp Viewer 3D - Info !

@1730)5 calibrate3DsplinePSF Run

2 4 16 VISPexport Show results

‘mrln;ﬁvec[ )

+ 28 Animate Rotate <]
2 10 zmin/zmax -840 160 save movie horizontal [

% Reset Polar angle theta 0

4 250 N

gdolelx

®show (X °
8 sho Show Controls save tif o0

0 -300 200 -100 [ W00 0 a0 40

Figure 10: A) Fofméf G'UI t"o draw a line ROI. B) Main 2D reconstruction window with a
line ROI. C) GUI for the 3D renderer. D) Side-view rendering of the localizations in the
line ROLI.
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